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Launching GoldMine 

Your first step is to launch GoldMine from your Windows desktop. 

   

 

1. Double-click the GoldMine                    shortcut. 

 

 

 

GoldMine Opening Screen 

 

This is the GoldMine opening screen. Here you must type your username and password in 

order to log into GoldMine. 

 

2. Click in the Username field. 

 

3. If your username for this course, MASTER, isn't there already, please type it. Then press v. 

 

4. Password: Student. 

 

5. Click the OK button (or press e). 
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GoldMine's Look And Feel 

When you start GoldMine, you'll see the following screen: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The GoldMine display is divided into three main sections: 

 

1. Top: Window title bar, menu line, and toolbar. 

2. Middle: Navigation pane on the left, work area on the right 

(currently showing one record window). 

3. Bottom: The status line. 

 

Note that when the navigation pane is open, the work area is shifted to the right. 

 

When performing tasks, you can either use the menu options on the menu line, or you can click 

an icon on the toolbar or an item in the navigation pane. 

 

1. Hold the mouse arrow over the New Company  toolbar icon. 

 

A yellow box pops up (these boxes are called "bubble help", or "tooltips"), explaining the 

function of this toolbar icon. Tooltips appear throughout GoldMine to show additional 

information when you need it. 

 

2. Slowly move the mouse arrow across the toolbar icons to see tooltips explaining each icon.  

WORK AREA WINDOW TITLE BAR 

MENU LINE 

TOOLBAR 

TAB BAR 

STATUS LINE 

NAVIGATION 

 PANE 
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In the work area, you see a window entitled "Carlson's-Day". This window is a GoldMine 

contact record.  

 

3. Click the Next Record  button on the top right of the contact, to move to the next contact. 

 

4. Click the Previous Record  button to move to the previous contact. 

 

You can also use the }key to move to the next contact, and the { key to move to the 

previous contact. 

 

5. Click the Last Record  button to jump to the bottom of the contact set. 

 

6. Click the First Record  button to return to the top of the contact set.  
 

You can also use b+ }and b+{ to move to the top and bottom of the contact 

set. And, you can use any of the links displayed in the navigation pane to select contacts.  

 

7. Click the Contacts > link on the top left of the contact record. 

 

The Contact List 

This is GoldMine's contact list. This handy listing of your contacts helps you find and select 

the contacts you want.  
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The main information on the selected contact is displayed in the bottom half of this window. 

Searches can be performed in the top right. You'll become more familiar with this window as 

this course progresses. 

 

8. Double-click the Carlson's-Day listing to return to the contact record. 

 

9. Open the Window menu, and choose New Contact Window.  

 

An entirely new contact list appears in the work area. You can navigate this window just as 

you navigated the original window. This way you can have more than one contact window 

visible if you require. 

 

10. Click the Minimize  button on the top right of the new contact list. 

 

Minimized Contact List 

 

GoldMine's various windows can be sized, moved around, minimized, restored — in all ways 

treated as separate objects. You can have as many windows as you need minimized in your 

work area, waiting to be restored and used. 

 

11. Click the Restore Up  button on the minimized window. 

 

12. Click the window's Close  button. 

 

13. Click Justine's Close  button. 
 

The contact record only minimizes. One contact record window will be active at all times. 

 

As you schedule activities and perform operations in GoldMine, you'll see these 

automatically involve the active contact. Whenever you do something concerning 

a particular contact, you'll need to have that contact on your screen and "active" 

when you do it. Having activities connected, or "linked", to the proper contact is 

central to how GoldMine operates. 

 

14. Click the Restore Up  button on Justine's minimized contact record. 

 

15. Double-click the title bar of Justine's contact record. (See next page for screen.) 
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Tabbed View 

This is GoldMine's Tabbed view. In this view, each window you open will appear as a 

separate tab.  

 

16. Click the Calendar button in the  navigation pane.  

 

A New Tab Displayed 

Us this view to show a lot of information at one time.  
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The down arrow  tab appears when you have more than one window visible, giving you a 

menu to select the window you want (just in case you've got tabs which have disappeared off 

the right edge of the screen). 

 

17. Click the "x" on the Calendar tab to close the tab. 

 

18. Click the window  tab to return to the Classic View. (You can also move between views 

with the Window | Arrange By submenu options. 
 

19. Click the Contacts button at the top of the navigation pane. 

 

The Navigation Pane Minimized 

If work area space is at a premium, you can temporarily minimize the navigation pane. 

Notice that you'll still have access to the shortcut buttons.  

 

The navigation pane shows context-sensitive information (as you just saw) relating to the 

window active in the work area. So you'll need it open, most of the time.  

 

20. Click the restore  button to display the navigation pane. 

 

GoldMine's "task bar" is another way to access GoldMine functions. It's like a 

toolbar which can be configured with icons representing any menu option in 

GoldMine, as well as external applications, web pages, and other complex task 

items. Task bar configuration is covered in detail in our System Administration 

course. You can toggle the task bar on and off by right-clicking over the toolbar 

area and choosing the Task Bar menu option. 
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Getting Help 

There are two ways to get help in GoldMine: 

 

The Help menu: GoldMine's Help menu accesses GoldMine's help system, including links to 

GoldMine's online forums. 

 

Context-sensitive Help: When performing an operation, the l key will bring up help relating 

specifically to what you are doing.  

 

 

 

ON YOUR OWN  

 

Review 

 

1. Practice moving around the contact set, using any of the 

methods described in this lesson.  

 

2. Use links in the navigation pane to jump to contacts.  
 

3. Use the contact list to scroll and select contacts. 
 

4. Use the Window | New Contact Window menu options to open and arrange several contact 

windows.  
 

5. Familiarize yourself with the Tabbed and Classic views. 

 

6. When you're done, leave only one contact window remaining onscreen. 
 

Practice 
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Creating a New Contact 

You’ll now add a new record to the contact set. 

 

1. Open the File menu. 

 

2. Choose New. 

 

3. Choose Company and Contact. 

(You can also use the New Company  toolbar icon, the New Company 

button on the contact record, or the New contact... link on the navigation pane. ) 

 

Creating A New Contact 

 

A new GoldMine record begins with the dialog box you see here. 

 

Some organizations create special record types for specific types of contacts. You can leave 

the Record Type field blank or select [Plain Contact Record] from the drop-down list to 

create an ordinary all-purpose contact record. 

 

4. Here, you'll leave the Record Type field blank. Press v to continue. 

 

These white squares where text can be typed are called entry fields. The cursor (the blinking 

line) indicates the "insertion point", where you can type text.  

 

5. Press v in the Company field. The cursor moves to the Contact field. 

 

6. Press j+v. The cursor moves back to the Company field. 

 

7. Click the mouse in the Ext. field. 
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You can click to the right of any field on this screen — and on your contact record — to open 

that entry field and begin typing text.  

 

These are the three ways you can move through any dialog box in GoldMine —v, 

j+v, and a mouse-click. 

 

8. Click in the Company field.  

 

9. Type Pam's Club. Do not press e. 

 

In a dialog box like this, one button always has a 

bold outline. This outline shows you that when you 

press the e key, that button will be clicked.  

 

10.  Press v to finish editing in this field and move to the next one. 

 

11. Type Pam Dalton in the Contact field, and press v. 

 

12. Click in the Phone1 field, type 3104593443, and press v. 

 

GoldMine will automatically format this phone number when you're done adding the record. 

Always add a phone number as numbers only, and let GoldMine add the dash and 

parentheses. 

 

The Ext. field is for a phone number extension. But you can also use it to hold other 

information. 

 

13. Ext: type the letter c.  

 

Lookup Entries 

These entries are choices from the 

field's lookup window. Selecting one of these items will insert that text into this field. You'll 

explore lookups in more detail in a moment. 

 

1. Press y to highlight Cell. 

  

2. Press v to accept the entry and move to the next field. 

 

If you use e to select an entry, you'll remain in the field. You can also select an entry 

with the mouse. 
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The International Phone Format option controls how the phone number will be formatted. 

If activated, this option will turn off automatic formatting for this phone number — so you 

can type in an international phone number. 

 

You'll find check boxes throughout GoldMine. When a check is present, the 

option is active. 

 

 

14. Click in the E-mail field, type pdalton@pamsclub.com, and press v. 

 

15. In the Web Site field, type www.pamsclub.com. 

 

The options at the bottom of this dialog will be covered later in this course. 

 

16. Clicking the OK button. 

 

And you've now added a new record to the contact set! 

 

You could have continued adding information in the previous dialog — often, 

however, you'll want to add a contact's basic information, then proceed quickly to 

the contact record to perform other operations. This is what you've done here. 

 

 

 

Lookup Windows 

You now proceed to the contact record where you'll continue adding information. Move back 

and forth through this window just as you did through the dialog box.  

 

1. Type A in the Dept field. 

 

2. Press y to highlight "Administration". 

  

3. Press v to accept the entry and move to the next field. 

 

4. The Last field has been automatically filled with the last name from the Contact field. 

 Press v. 

 

If the contact's last name changes in the Contact field, GoldMine will 

automatically update the Last field. The Last field always contains the very last 

word in a contact's name. If the name ends with "Jr.", the Last field would show 

"Jr." — something to watch out for. 

 

5. For now, put nothing in the Title field, and press v. 
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6. Type Pam in the Dear field, and press v. This field holds the salutation for any letters you'll 

write. 

 

You might put "Pamela" in this field if you wanted to be more formal. Tailor the contents of 

the Dear field to the tone of your client contact. 

 

7. Click the lookup  button in the Source field. 

 

Lookup Window 

This is a GoldMine lookup window. Lookup windows are available for nearly every field in 

GoldMine, if configured by your system administrator. This window lets you add, edit, and 

select lookup entries for this field. 

 

You can use your keyboard and the scroll bars to move around this window. 

 

8. Press r. The highlight jumps to "Radio", which is the first entry beginning with "r".  

  

9. Click the Select button. 

 

You return to the Source field, and "Radio" has been added.  

 

10. While still in the Source field, and with your mouse pointer over the field, click the right 

mouse button. 

 

This is another way to bring up the  lookup window. Pressing the m key while in an entry 

field will also bring up the lookup window.  

 

 

Lookup windows can be set to automatically pop up  and require entries to be 

selected from the list before proceeding. They can also be configured to perform 

other functions which cut down on data input and help standardize field contents 

for all users. 
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Adding A Lookup Entry 

1. As you use GoldMine, especially in the beginning, you'll often need to add lookup entries. 

Click the lookup window's New button. 

 

Adding A Lookup Entry 

 

2. Type Web Page; (include the semi-colon). 

 

3. Press e to finish adding this new lookup entry. 

 

4. Click the Select button (or double-click the Web Page; entry). 

 

"Web Page" is added to the Source field, after "Radio", and GoldMine automatically adds a 

comma! A semi-colon at the end of an entry combines the entry automatically with 

whatever's in the field, and places the comma correctly. (If you select an entry without a 

semi-colon when there's already information in the field, the new entry will replace that 

information.) 

 

A pair of slashes // following a lookup entry lets you include a comment, which will not be 

inserted into the field. You can use this feature to include abbreviations and codes in lookup 

windows, with text explaining what the abbreviation or code means. 

 

 

Write access to the lookup window is often restricted to the average user, so you 

may not be able to add or edit entries. 
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Editing A Lookup Entry 

Often you'll find you need to edit your lookup entries. If you decide on different codes, brand 

name changes, and so on. 

 

1. Move back to the Title field using the j+v keystrokes. 

 

2. Open the lookup window. 

 

3. Scroll down and highlight the "Mangler" entry. 

 

However true this typo may be at times, it needs to be corrected. 

 

4. Click the Edit button. 

 

5. Type Manager. 

 

6. Click the OK button. 

 

7. Click the Select button. 

 

"Manager" (the correct title for this contact) is added. 

 

 

 

The ZIP Code Database 

1. Move forward to the Address field. 

 

2. Type World Headquarters and press v. 

 

3. Type 5000 Sunset Blvd. in the second address field and press v. 

 

4. Type Building A in the third address field. 

 

5. Click in the Zip field. 

 

GoldMine maintains ZIP codes in a special database, and when you type in a ZIP code 

already on file, GoldMine will fill in the city and state automatically. 

 

6. Type 90029 and press e to finish editing. 

 

Since GoldMine has this city and state on file, they're automatically inserted. But what would 

happen if this ZIP code wasn't in the database? 
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7. Click in the Zip field.  

 

8. Clear the information, type 90210, and press v. 

 

Zip Code Profile dialog 

This box will appear if the ZIP code you type is not already on file.  

 

9. Replace the information in the City field with Beverly Hills. 

 

10. Since you already have the proper state in the field, click the OK button to finish adding the 

new ZIP code profile, and insert the information into your record.  

 

While using GoldMine, you might want to leave the Country field empty if the contact is in 

your own country. 

 

The Merge field is for any special code you might want to use to identify this contact for mail 

merges. Mail merges are explained in the Correspondence section. 

 

 

 

The Tab Bar 

 

 

The Tab Bar 

The lower half of the contact record is separated from the upper by the tab bar. The tab bar 

controls what information displays in the bottom half of the contact record.  

 

1. Click in the Prod. Interest field.  

 

2. Press v. 

 

When fields are available in the bottom half of the contact record — as they are when the 

Summary or Fields tabs are selected — editing jumps from the top half to the bottom half.  
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3. Type Corporate offices closed on weekends. 

 

Comments field information should be of general importance to all users, and not 

something that will change frequently. 

 

4. Finish editing your new contact by pressing e. 

 

A tab is selected by clicking on it to reveal the information it describes. You can also use the 

v key (when no field is open), or the z or x keys, to move through your tabs. Also, each 

tab can be displayed by a unique bkey combination, as detailed below: 

 

Summary 

b+S 

This tab, currently selected, shows a brief rundown of the important 

events in the contact's history. 

Fields 

b+F 

This tab shows the user-defined fields on the contact. These fields are set 

up by your system administrator. Ultraplay has its own custom fields. 

GM+View 

b+V 

This tab shows a customizable view — a web page HTML file — 

containing any information you wish to put there. 

Notes 

b+N 

This tab shows any of the notes attached to the contact. 

Contacts 

b+C 

This tab shows any additional contacts associated with the contact. 

Details 

b+D 

This tab shows the contact's detail records. 

Referrals 

b+R 

This tab shows the contact's referral links. 

Pending 

b+P 

This tab shows the activities currently pending for the contact. 

History 

b+H 

This tab shows the contact's completed activities. 

Links 

b+L 

This tab shows the contact's linked documents. 

Relationships This tab, with no shortcut keystroke, displays relationships between 

contacts in a tree view. 

Other tabs are available for some of the more advanced GoldMine features. 

 

5. Practice clicking on a tab or using the control key combinations listed above to see a sample 

of the information that each tab shows. 

 

The upper half of the contact record shows you basic contact information — name, address, 

and other important fields. The lower half shows varying supplementary information on the 

contact. The lower portion (referred to as a view) can also be resized, to display more 

information. 

 

6. Positioning the mouse pointer at the bottom edge of the contact record, until it becomes a 

double-headed arrow  . Then click and drag the border up or down. 
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7. You can also size the tab bar and views upward. Point the mouse at the border above the tab 

bar until the splitter bar  appears. Then click and drag the border up. Take care not to 

obscure any of the fields on the upper half of the contact record.  

 

You can access tabs or change their order with the down arrow  tab, or through 

your GoldMine Options. You can also click and drag a tab to any other location 

on the tab bar.  

 

 

 

Duplicate Records 

The Duplicate Record option lets you duplicate much of the contact record currently displayed. 

This makes data entry easier when another contact from the same company. (The best way to 

manage multiple contacts at the same company is to use Additional Contacts, which are covered 

in the Contact Maintenance section of this course.) 

 

1. Move to Bob Stamper's contact. 

  

2. Click the New contact... link in the navigation pane. 

  

3. Click the Create duplicate record option to activate it. 

 

4. Click the View in new window option to activate it. This option will show the new record in 

a new contact record window. 

 

The Duplicate Checking area is a very handy way to avoid adding people already in the 

contact set. The active items will be compared to your contact set, and you'll be alerted if the 

information is already there.  

 

5. Bob happens to have a brother who just started work at K.D. Quarters. Click in the Contact 

field, and type Jim Stamper. 

 

6. Click in the Phone1 field and type 5155553129. 

 

7. Click the OK button. 

 

And Jim is added — with most of the same information on his record as Bob's. The Title 

field and the Dear field are not duplicated, nor is any of the information on the Summary 

view. Any information shown on the Fields view, however, is duplicated.  

 

8. Finish editing this contact record. 

 

9. Close the new contact record window. 
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ON YOUR OWN  

 

Review 

 

1. Add a new contact record with your own name and 

company (be sure to deactivate the Create duplicate 

record option!). Instead of your own phone number, use 

(555)555-5555. 

 

2. Familiarize yourself with lookup windows. 

 

3. Practice moving around while editing. 
 

4. When done, return to the top of the contact file.  

Practice 


